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KATA PENGANTAR

Assalamu’alaikum Wr. Wb.

Alhamdulillah, Puji dan Syukur kita panjatkan kehadirat Allah SWT, karena atas keberkahan dan
kesehatan yang diberikan oleh Nya, akhirnya Panduan Learning Management System (LMS)

Fakultas Ekonomi dan Bisnis Universitas Ibn Khaldun Bogor telah selesai dibuat.

Banyak sektor yang terdampak pada kejadian ini, tidak terkecuali dunia pendidikan khususnya
perguruan tinggi sehingga pembelajaran online sudah tidak dapat dihindarkan lagi, dimana saat ini
kita berada di tengah masa pendemi COVID-19. Kebiasaan pertemuan secara tatap muka dikelas
digantikan dengan pertemuan secara online. Maka dari itu FEB UIKA Bogor berusaha untuk terus
berkontribusi walaupun berada dalam kondisi pendemi dengan menghadirkan Learning

Management System (LSM).

Penggunaan LMS UIKA saat ini sudah tergabung dalam SPADA (Sistem Pendidikan Daring) Indonesia
Kementerian Pendidikan dan Kebudayaan Republik Indonesia yang merupakan bukti nyata
kontribusi FEB UIKA bagi pendidikan terutama dimasa pendemi ini. Panduan ini hanya diperuntukan

di internal FEB UIKA Bogor.

Panduan ini walaupun masih banyak kekurangan diharapkan akan membantu para operator, dosen
ataupun mahasiswa didalam menggunakan aplikasi ini didalam kegiatan belajar dan mengajar.
Tidak ada gading yang tidak retak, tidak ada kesalahan ataupun kekurangan didalam setiap hasil
karya manusia. Setiap masukan yang membangun akan sangat dibutuhkan untuk perbaikan dan
upgrading sistem LMS ini dimasa yang akan datang. Terima Kasih dan selamat menggunakan

Panduan ini dengan sebaik-baiknya.

Alassalamu’alaikum Wr. Wb.

Hj. Titing Suharti, S.E., M.M.

Panduan LMS (Learning Management System) | i



DAFTAR ISI

KATA PENGANT AR Lttt ettt et e e e e e e e e e e e e e e e e s e e b be b et e e et e ee et eeaaeaaaaaaeseesassaaaaaaaannnnnn i
DAFTAR TSI ettt ettt et e e et e e e e e e e e e e e e e b et e e eeeeeeeeeeeaaaaaeeesassasaaanannnnnnnsennennee ii
DAFTAR GAMBAR ...ttt ettt e et e ettt et e e e e eeaaaeaeeeesseesasaaaannnnsnnnenns iv
PENDAHULUAN ...t e ettt s e s e e e e e et e et ee b s e s e e eeeeneenaenss e e s e eeaeaeee 1
Y |V =Y o o [V =TI =] (= T 1| T S PRSPPI 1
B.  Pengaturan Bahasa......ccciiccuiiiiie ettt e e et e e e e et a e e e e e e aaraaaaaeaan 2
C.  MembUAt ACCOUNT USEI..ciiiiiiiiiiiieeiie ettt ettt ettt et e sat e e st e sme e sane e saneesmree e 3

1. Pendaftaran IMandiri ....c.c.cooeerieiee et 3

2. Pendaftaran oleh Admin/OPErator .........ccccuvieeeciiei ettt et e e ebee e e 4

3. Pendaftaran IMassal.......ooei it 6

(D o o T- L U] =] o W e T T U ST 7
1. MEMDBUAL CONOIE ...ttt st e s s 7

2. MENGIST CONOIT «.vveeeeeiieee ettt e e ettt e e e e ettt e e e e e e s eeabtaeeaeeeesbtaeeeessasasraeeaeeeannses 9

E. Pengaturan Course (Mata Kuliah) ........coooiiiiiiiiiiiciiieee e 10
1. MEMBUAE KEIAS..ciiieiiiii ettt sttt ettt e s e s 10

2. Membuat KUNCE KEIAS .....cc.uiiiiieiiieiiie ettt 12

3. Menghapus Course (Mata Kuliah).......cc.ueeeiiiiiiiiiiiic e 13

4. Membuat Kehadiran/Presensi Course (Mata Kuliah).........cccccoovvviiiiieiiiiiieciiieecceieeens 15

5. Melihat Rekap Kehadiran/Presensi Course (Mata Kuliah) ........ccccooveviiieniieninienieenneens 19

6. Mengekspor Kehadiran/Presensi Course (Mata Kuliah) .........cccueeeeeenieeenieinnecneeeneeenns 21

7. Mengatur Settingan Kehadiran/Presensi Course (Mata Kuliah) .........ccccovveevivieeiiieneenn, 21

Fo o PENGATUIAN USEI ..uuiiieiiiieeeeeeeceee et e ettt ettt s s s e e e e e e eeeebabbaaanseeeeeaeenennsens 22
1. Memasukkan Peserta Kelas ........ccooeeriiiiiiiiiieiiceeeeeeee e 22

2. Menghapus PeSerta Kelas.......cuuuiiiiiiiiiiiiei ettt e e et e e e e s s srrn e e e e e eaes 25

3. Memasukkan Peserta SEMENTAra ......ccoceerueerieeriiee et 27

G, Pengaturan Profil ... e 28
H.  Pengaturan Course (Mata Kuliah) ..........ccoiioiiiiiiiie e 30
1. Membuat PENGUMUMEM ......uiiiiii ittt ecireee e et e e e e e ebree e e e e e s erbee e e e e e senbreaeeeeeennnens 32

2. Membuat Materi KUliah ........c.cooiiiiiiiniee e e 33

3. Mengunggah (Upload) Materi MENZaJar.........cccceeeecieeeeiiieeeecieeeeireeeeereeeeeveeessnreeeeeens 35

4. Membuat PENUZASAN/UjJIAN.....c.cciiieiiieeiiee e eteesteesteesreesteesreestbeesbeesbeesbeesareasaneans 38

5. Mengisi Daftar Hadir (Presensi) Perkuliahan .........ccccccveeeeiiieiiiiie e 40

6. Mengunduh (Download) Materi/Tugas Perkuliahan ..........ccccocveeiiiiiiencieeccee e, 41

ii | Fakultas Ekonomi dan Bisnis UIKA Bogor



7. Mengunggah (Upload) Tugas/Ujian Perkuliahan ........c.ccccoovveviiieniiiniiicccee e 42

8. Mengelola Hasil Tugas/Ujian Perkuliahan..........ccccocveiiiiiiiieiiieec et 44
9. Mengekspor Hasil Tugas/Ujian Perkuliahan ..........cccccovvieiieeniiiciieecieccrec e 46
TEOUDIESAOOTING ...ttt e e e e et e ettt e b bbb e s eeeeaaaaaaaaaeaaeeeeeesenessnnnannes 48

Panduan LMS (Learning Management System) | iii



DAFTAR GAMBAR

GAMDBAr L WED BIrOWSET «..eviiiiiiiiiiitteee ettt ett e e s ettt e e e e s sttt e e e e s saabbeaeeeessaabbeaeeeesssanstaaeeessannses 1
GaAMDBAr 2 LINK LIMIS. ..ottt ettt e e ettt e e e s sttt e e e e e s saabbeaeeeessanabteeeeessannseaeeeessansses 1
GaAMDBAr 3 VErsi DESKLOP ooiiiiiiiiiiii e e e e e e e e e e e e e e e e e s e e e s e e aaabbaaraesaaraeeareeaeeaaeaans 2
Gambar 4 Versi HANAPRONE ......c..uviiiiie et e e e s st e e e e s s s snbreeeeeessnnes 2
Gambar 5 Mengganti Bahasa ..........ueiiiiiiiiiiiiie ettt e e e e s s ra e e e e e e enees 2
Gambar 6 Login Pendaftaran Mandiri..........coeeeiiiiiiiiiie ittt e e e e e sbaae e e e e e enees 3
Gambar 7 MembUAt ACCOUNT ......uiiiiiiiie ettt ettt et e e stee e s sbr e e s sbae e s sbaeesssbaeesssbaeessntaeessnsees 3
Gambar 8 PEMbBUALAN ACCOUNT ....eeiiiiiieiiiieecrieee et e e stee e see e e stee e s st ee e stae e e staeesenaaeessnsaeessnsaeesensees 4
GAMDBDAr G USEI BANU coiiiiieiiiiiie e ieiiteeee sttt e e e ettt e e e s sttt e e e e s ssbbaeeeeessaasbeaeeeessanstateeeessansseneeeessnnsses 4
GaMbBAr 10 1SIAN USEE BalU...ciiiiiiciiieeieiiiciiieeee s seeiitteeeeseetreeeeessssabteeeeeesssnbeaeeeessssnseneeeessassseneeessssnes 5
Gambar 11 Pengisian USEr FIEId ........couiiiiiiiie ettt e e e st e e e s s esaarae e e e e e ennes 5
Gambar 12 Pengisian USEr FIEIA ........coui ittt e e e et e e e s s earaae e e e e e enees 6
GaMbBAr 13 UNGEAh USEIS  .oeiiiiiiiiiiiiee e ccctieeee ettt e e e e et e e e e e e et ae e e e e s seabtaeeeessssttaeeaessesssaneaessannes 6
Gambar 14 Unggah UsSer IMasal........eeee ittt e e et e e e e e etta e e e e s s enataeeeeeeennes 7
Gambar 15 Awal Membuat CONOIT ...ciiiiiiiiiie e e e s s sbra e e e e s seaees 8
Gambar 16 Proses Pengisian Field CONOIt........ccccuiiiiiiiiiiiiiieeececeec e 8
Gambar 17 Hasil Membuat CoNOIt .......oocuiiiiiei e e e e s s saaree e e e s sennes 9
Gambar 18 MemasukKan CONOIT ......ciiiiiiiiiiie et e e e e e s s ssabraeeeeesennes 9
Gambar 19 Proses Memasukkan CONOIt ........oocuiiiiiiiiiiiiiie ettt e e s e s siee e 10
Gambar 20 Hasil Proses Memasukkan CoNOIt .......c.civviiiiiiiiiieiiiec et 10
Gambar 21 Membuat Kelas.......oieiiiiiiiiieeee e e st e e s e e e s 11
Gambar 22 Proses Pengisian 1dentitas Kelas ...........uuueeeeeeiiiiiiiiiiiic e e e e e e 11
Gambar 23 Pengisian dan Penyimpan Kelas..........uuuiiieiiieiiiieii e ccccccrrrrrevee e e e e e e e e e e 12
Gambar 24 Memulai Membuat KUNCi Kelas ........ccuviiiiiiiiiiiiie ettt e e 12
Gambar 25 Mengaktifkan KUNCi KEIas..........eeiiiiiiiiiiiii it e e 13
Gambar 26 Membuat KUNCi KEIAS ....ueiiiiiiiiiiee ettt e e e s saaae e e e e 13
Gambar 27 Menghapus KEIAS........uuuiiiiiiiiiiiiie ettt e et e e e e e e e e e e esaaraeeeesesnssaaeeeeenns 14
Gambar 28 Pemilihan Tahun AKQdemik .......ccoouiiiiiiiiiiiee e 14
Gambar 29 Pemilihan Program StUdi ........cccccuiiiiiiiiiiiieieeeecc e e e e e e e e e e 14
Gambar 30 Check List Mata Kuliah Yang Akan DiNapus ........ccoooiiiiiiiie e, 15
Gambar 31 Konfirmasi Pengahapusan Kelas ........cuuveiiiiiiiiiiiiiiiiiiiiieec et e e esveee e e 15
Gambar 32 Membuat Kehadiran Kelas..........cciiiiiiiiiiiiiciiieeee ettt e e s sarae e e e 16
Gambar 33 Mengaktifkan/Membuat ACTIVITY......cceciiiiieeiirie ettt e raeeree s 16
Gambar 34 Pemilinan 1coN AttENUENCE ... ..ciiiiiiie ettt ettt e e e saee e s sere e s saaeeeens 17
Gambar 35 Membuat Kehadiran Kelas..........ccuiiiiiiiiiiiiiieeiiicee e e e e e 17
Gambar 36 Pengisian ldentitas KENAdiran ... 18
Gambar 37 Menyimpan Pembuatan Kehadiran ... e 18
Gambar 38 Hasil KEhadiran Kelas........cuiviiiiiiiiiiiieiee et e e s e e s serae e e e e 18
Gambar 39 Pengisian Identitas Kehadiran Kelas ..........cooccuviiiiiiiiiiiiiiie i e e 19
Gambar 40 Pengisian Identitas Kehadiran Kelas ..........coccciiiiiiiiiiiiiiiiee e 19
Gambar 41 Memulai Rekap Hadil .....cccooiiiiiiii ettt e e s arae e e e e 20
Gambar 42 Menu KeNadiran .....ocueuiiiiii ettt st e e s s s e e e e s s sabbaeeeeseaas 20
Gambar 43 Membuat KENAAIran .......couiviiiiiii e e e e e 20
Gambar 44 Tampilan Kehadiran Kelas..........ccuiiiiciiieiiiiniiiieee ettt e e s saraee e e s 20

iv | Fakultas Ekonomi dan Bisnis UIKA Bogor



Gambar 45 Eksport Kehadiran Kelas..........ceeieiiiiiiiiei it e e e e vrae e e e 21

Gambar 46 Pengaturan Kehadiran Kelas ..........ccuuiiiiiiiiiiiiiei et evrre e e e e 22
Gambar 47 Memasukkan Perserta Kelas ........oucuuiiieeiiiiiiieee ittt e e e 22
Gambar 48 Proses Memasukkan Peserta Kelas.........covvuiiieiiiiiiiiiiieiiiiiieee e 23
Gambar 49 Memasukkan Data Peserta Kelas ........cccccvviiiiieiiiiiiiiiieee et e e ssiiee e e e s s 23
Gambar 50 Pemilihan Peserta Kelas.......iviiieciiiiiee ittt e e vree e e e e 23
Gambar 51 Pemilinan ROIE PESEIta .....ccovuiiiiiiiiiiiiee ettt sttt e e sare e e s 24
Gambar 52 Hasil INput PeSErta KeIas..........eeiiicciiieiei ettt arae e e e 24
Gambar 53 Pemilihan Peserta CONOI .......uiiiiiiiiieic ittt be e s s 25
Gambar 54 Pemilihan Peserta dan Role CONOIt .......ccoociiiiiciiiiiiee et 25
GamMbBaAr 55 HaSil CONOIT ..uviiiiiiiiiieee et e e s s esbee e e e e s ssabere e e e s sesabaneeeesssnnnens 25
Gambar 56 Pemilihan Mata Kuliah Yang Akan DiN@apus..........coecuiiiieeiiiiiiieeeeserciineeee e ssiieeeee s 26
Gambar 57 MemuI@i KEIAS .....ocuuiiiiiiiiiiiieiee ettt e e s e e e s ssabeae e e e s seabeaeeeessennneee 26
Gambar 58 Pemilhan Peserta Yang Akan Di HapuS ......ccuvieeieiiiiiiiiee et eeitee e e e e 27
Gambar 59 Konfirmasi Penghapusan PESerta........ccccoeecuiiieiiiicciiiiec ettt 27
Gambar 60 Memasukkan Peserta SEMENTATa ......cccceevvcieeiicieeerieeeerree e et e e st e e ssaee s s sebeeesnaaeeeenane 27
Gambar 61 Memulai Pengeditan Profil ...ttt e e e 28
Gambar 62 TampPilan Profil...........eeeei i e e e e e ettt e e e e e e eabaa e e e e e e ennees 28
Gambar 63 Memasukkan Gambar Profil ..........ccuiiiieiiiiiiiiiee it 29
Gambar 64 Memilih FOTO Profil ........ooiiiiiiiii e e e e s s sabae e e e e e s saneee 29
Gambar 65 Memasukkan FOtO Profil.........ccoociiiiiiiiiiiiieieieeetec et 30
Gambar 66 Hasil Update Gambar Profil ...........ccuiiiiiiiiiiiiie et e e 30
Gambar 67 Profil Mata Kuliah Yang Diajar .......cc.uueeeeiieiiiiiee ettt e e esvare e e e e 30
Gambar 68 Mengkatifkan Pengaturan COUISE........ceiiiiiiiiiieeeieeciieeeeeeeecttee e e e e eecttre e e e e e eebraeeeeeeeeanees 31
Gambar 69 Memulai PENZAtUran COUISE ......uuuiiiiiiiiiiiieeeieeeeeeeeeee e e eeeeeeeeseeenensrasrsrrreererreeeeeaeaaaaaaaens 31
Gambar 70 Pengaturan Aktifitas KUliah..........ooociiiiiiiiiiii e 32
Gambar 71 Pengaktifan AKLifitas ........occciiiieiiiiiee e 32
Gambar 72 Pengaturan Konten PENGUMUMAN .......ciiiiiiiiiiiiee ettt e et e e e s s sabaae e e e e s saneee 33
Gambar 73 Hasil Pembuatan PENgUMUMAN ..........iiiiiiiiiiiiiee ettt eee e e e et e e e e e ebare e e e e s eannes 33
Gambar 74 Membuat Materi KUIIah.......ovi i 34
Gambar 75 Proses Pengisian ldentitas Mata Kuliah ..., 34
Gambar 76 Hasil Pembuatan Materi Kuliah...........cooiiiiiiiiiiii e 34
Gambar 77 Proses UNGEah File.......coii ittt e e s s sbrae e e e s s sabane e e e s s snneee 35
Gambar 78 Pemilihan File Yang Akan DiuNggah ..........cccuiiiiiiiiiiiiiiiec et e e 35
Gambar 79 Pilih File yang Akan DIUNGEah .......cc.uviiiiiiiiiiiiec ettt e e e sbaee e e s e 36
Gambar 80 Tampiilan Unggahan Materi Kuliah..........coccoiiiiiiiiiiiiie e 36
Gambar 81 Jenis Materi UNgEahan ...........ooiiiiiiiiiiiec ettt e e ttre e e e s e eaaaee e e e e e enenes 37
Gambar 82 Hasil AKhri Unggah Materi..........uuuiiiiiiiiiiieiiiceccecc e e e e e e e e 37
Gambar 83 Membuat PenUZasan/UjJian ......cccueeeeueieiiiieeeeeeee et eereeeeetree e et e e eeaeeeeeteeeesareeeenans 38
Gambar 84 Memulai Pengisian PEnUZasan/UjiaN.........cceccueeiieeiieenieesieesreesireesreesiveesveesveessneenns 38
Gambar 85 Proses Pengisian Penugasan/UjJian ......c..cccueeiueerireeriieenireeeeeesreesreesveesireesveesaveessneenes 39
Gambar 86 Jenis Unggahan Penugasan/UjJian ........cceeuueeiieeiieeiieesireeeeeesveesreesveesaveesveesaveessneenes 39
Gambar 87 Memasukkan Pembatasan Penugasan/Ujian........ccccceeeeieeeecciieeeiiiee e 39
Gambar 88 Jenis Pembatasan Penugasan/Ujian .........ccceieecuereeiieeeeiiee et eeireeeeetee e 40
Gambar 89 Tampilan PenUZasan/UjJian .......cccueeieueieeeiieeeeeeieeeeceeeeeeree et eetree e eeaeeeeereeeeeareeaennns 40
Gambar 90 Pemilihan Mata Kuliah Kehadiran ...........cooociiiiiiiiiiiiiie e 40

Panduan LMS (Learning Management System) | v



Gambar 91 Submit attendance Untuk Mengisi Kehadiran .........cccovveeiiiiiiiiiieei i 41

Gambar 92 Pemilinan KeNAdiran .......cuiiiiieiiiiiec ettt stee e s sa e s s naeeessareeesnnes 41
Gambar 93 Hasil Kehadiran Kuliah ........oocuiiiiiiin e e e 41
Gambar 94 Memilih Mata Kuliah Unduhan .........ccuuiiiiiiniiiiee et 42
Gambar 95 Materi Siap DiUNdUN ... e e e e e e e 42
Gambar 96 Pilih Mata Kuliah Penugasan/Ujian........c..cccveeiieeiiieeiiiee e ecieecstee e ereeeveeeteeesvae v 42
Gambar 97 Klik Mata Kuliah Penugasan/UjJian .........cueccueeeiuieiiieeeireeeiee et eetee e v e eveeeeveeenveeeaee s 43
Gambar 98 Unggah PenuUZasan/UJIaN .......c.ccceciuiieeiiieeeeieeeeeieeeceiteeeeteeeeeiaeeeeeaveeeetaeeesnreeesnreeens 43
Gambar 99 Memilih File Yang Akan DiUNgZah...........cooiiviiiiiiiiii e e e e e e e 43
Gambar 100 Menggungah File Penugasan/UjJian .........cccueeeeieeeeeiiieeeeiiieeecieee et e eeveeeeeveeeeeveeeeenns 44
Gambar 101 Menyimpan Penugasan/UjJian .....c...coocveeeiieeeeeiieeeeecieeeeeteee et e eeeteeeeetaeeesetreeeseaeeeeens 44
Gambar 102 Hasil Unggah Penugasan/Ujian .........cccciueecieeiieeiiieeiitieeieeesieessteesvessreesteeestaeesaesnee s 44
Gambar 103 Memulai Pengaturan TUBAS/UjJIan .......cceccueeeiieeiiieeeiiieeiteeesteeesteeerteeeteeeteeetaeesaesree s 45
Gambar 104 Pengisian Tabel PenuUZasan/UjiaN ........cucccueeeiieeiireeiireeeeiee e esteeesreeeteeeeteeesteeesraeensee s 45
Gambar 105 Unduh Hasil Penugasan/UjJian ..........cccueeeeiiieeeiiiiee e ceieeeesireeeeiveeeeteee e snveeesnveeens 46
Gambar 106 Konfirmasi UNAUNAN ........cooiiiiiiiei ettt e e s stee s s see s ssae e e snareeesnes 46
Gambar 107 Menyimpan Hasil UNdURan ... e e e e e e e 46
Gambar 108 Memilih Mata Kuliah Yang Akan Di EKSPOF ...cccveeiiiiiiii e e e 46
Gambar 109 Pemilinan Grades........uueiii ittt e s e e e s s e e e e e s s sarraeeeeseas 47
Gambar 110 Tampilan Tabel Grader .......uuveiiiiiiiiiiee e e e s s sbrae e e e e seans 47
(G- Taq oF- [l B B Y To Tl V1= TIPSR 47
Gambar 112 Menyimpan File Hasil UNdUR ...ttt 48

vi | Fakultas Ekonomi dan Bisnis UIKA Bogor



PENDAHULUAN

Elearning atau pembelajaran online pada saat ini tidak dapat dipisahkan dari pendidikan,
keberadaannya kian jelas dibutuhkan ditambah ketika Covid-19 melanda Indonesia diawal tahun
2020. Dunia pendidikan “dipaksa” untuk mau menggunakan atau bahkan beralih ke model

pembelajaran secara daring (online).

Banyak aplikasi pendukung untuk media pembelajaran secara daring, mulai WA, email, Youtube dan
lainnya. Universitas Ibn Khaldun Bogor Khususnya Fakultas Ekonomi dan Bisnis menyediakan LMS
(Learning Management System) yang berbasis aplikasi MOODLE (Modular Object-Oriented Dynamic
Learning Environment) dimana melalui aplikasi ini dosen dapat memberikan materi berupa teks, web,

animasi, ebook, presentasi, ujian dan belajar secara daring.

Aplikasi LMS UIKA sudah terkoneksi dengan SPADA (Sistem Pembelajaran Daring) Indonesia yang
dikelola oleh Kementerian Pendidikan dan Kebudayaan Republik Indonesia. Pada modul LMS ini
diuraikan penggunaan bagi admin, operator, dosen maupun mahasiswa, dimana perbedaannya hanya

pada hak akses LMS saja.

A. Memulai elearning

Secara umum untuk memulai elearning (LMS) UIKA dapat diakses melalui perangkat yang
dimiliki, baik komputer PC, Laptop atau Handphone. Berikut adalah langkah awal memulai LMS
UIKA:

1. Buka web browser Anda lalu ketik elearning uika pada perambah pencarian

2. Setelah muncul, klik pada tautan yang tersedia

3. Muncul tampilan awal LMS UIKA

Goc gle cleaming uka

Qm images 6D Ne s §More
AbOUL 187,000 results (0 47 second
Go Ie eleaming ukabogor ac id = Transiate this page 2
Leamning Management System of UIKA Bogor
- ———— wweeybur tacy!

staff. Salaam. UKSI UIKA Bogot. Search Courzes Go.

(-

Q  elearning uka Learning Management System ... Teknik Mesin
Loncat ke konten utama Teknik Pengaturan. Aljsbar Linear +
Q  elearning uika - Google Search indonesian () Enghsh (en Responsi. Ayabar Linear +
@ Leaming Management System of UIK. elearning uka-bogor ... FAI Courses
Tahus NAP Sear
© LMS UIKA: Administration: Users: A - eleamning uika bogor.ac... Tahun A
@ Dashboard - elearning wika-bogor d h FTS
Gambar 1 Web Browser Gambar 2 Link LMS
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Learning Mansgement System & X o+

> C O @ eleaminguika-bogoracid Qax OMGY

Learning Management System of UIKA Bogor
!

& Navigation
Welcome to LMS of UIKA Bogor! Arome

Qsite anncuncements

> Courses

Uik mabasiswa: yang beluem memiik akun d sistom LMS UIKA, skakan Mendaftar Sebagst Pengs

1o croate shon, ple y scaderic st
Saaam
UKS1 UIKA Bogor
Soarch Courses B
Course categories

» Expand ot

» Tahun Ajaran 2020/2021 - GASAL
» Tahun Ajaran 2019/2020 - GENAP

Gambar 3 Versi Desktop

Welcome to LMS of
UIKA Bogor!

Untuk mahasiswa: yang belum memiliki
akun di sistem LMS UIKA, silakan
Mendaftar Sebagai Pengguna Baru
dengan mengisikan Nomor Pokok
Mahasiswa (NPM) sebagal Username dan
Password sama dengan password SIAK.

Eor lecturers: in order to create a new
course sesslon, please contact your
faculty academic staff.

Salaam,

UKSI UIKA Bogor

Search Courses

Gambar 4 Versi Handphone

B. Pengaturan Bahasa

Pada LMS terdapat pengaturan untuk bahasa, bahasa yang tersetting menggunakan bahasa
Inggris dan jika ingin diganti menjadi bahasa Indonesia, berikut adalah langkah pengaturan
bahasa pada LMS:

1. Pada tampilan awal LMS disamping user (tidak perlu login)

2. Klik menu Bahasa dan pilih bahasa yang anda inginkan

(o ey
®  (@English (en)~ Dasen Ujicoba FEB UIKA i

English (en)

Learning Management System of UIKA Bogor naonesan gy O @

# Home @ Dashboard £ Events £ My Courses [TETINTATTTNTTY IS Hide blocks ¢ Standard view

Gambar 5 Mengganti Bahasa
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C. Membuat Account User

Tahap awal didalam penggunaan LMS adalah memiliki account yang valid, dimana setiap orang
yang terlibat didalam LMS, mulai dari admin, operator, dosen maupun mahasiswa harus
mempunyai account yang terdaftar didalam sistem. Dimana didalam LMS UIKA terdapat 2 (dua)
jenis model pendaftaran, yaitu 1) pendaftaran account secara mandiri, 2) pendaftaran yang

ditangani oleh admin (baik amin universitas, admin prodi, maupun operator prodi).

1. Pendaftaran Mandiri
LMS UIKA memberikan kemudahan kepada mahasiswa untuk membuat account secara
mandiri, sebagai cara adaptasi awal LMS bagi pengguna baru. Adapun syarat utama dari
pendaftaran account LMS secara mandiri adalah pendaftar harus memiliki account email
yang aktif, karena akan dikirimkan konfirmasi link pendaftaran ke email tersebut.
Berikut cara untuk melakukan pendaftaran LMS secara mandiri:
a. Pada halaman awal LMS, klik tombol login
b. Klik tombol create usser account pada menu login

c. Isi Form New Account (tanda merah wajib diisi)

Forgotten your usemname or password?
Cookles must be enabled in your browser ©

Some courses may allow guest access

& Navigation

@ Home
@20 announcomarts
» Courses

is your first time here?

Jaccess 1o this site, you first need to create an account

. Create new account l

Gambar 6 Login Pendaftaran Mandiri Gambar 7 Membuat Account
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D... 3, |uKkA

Univesbiias 56 Rhaicun Boger

w account
w Coliapse all
~ Choose your username and password

Username @ | Diisikan nama pengguna

-Mssrg userame

The password must have at least 8 characters, at least 1 digit(s), at least 1 lower case letzer(s)

5 ° L - -
Poword Password terdiri min dari 8 karakter, disarankan

gabungan huruf, angka dan tanda baca

~ More details
/I | Diisikan email aktif
Email address O

Email (again) O /1 | Pengisian ulang email aktif
i

First name O /1 | Nama Depan

Surname © /“ Nama Belakang

Cityiown Bogor

Country Indonesia D

[ ™ e

There are required fieids in this form marked @

Gambar 8 Pembuatan Account

2. Pendaftaran oleh Admin/Operator

Selain medaftarkan account secara mandiri, LMS juga memiliki fasilitas untuk mendaftarkan

user melalui admin/operator, berikut adalah langkah-langkah pembuatannya:
a. Masuk melalui account admin/operator
b. Klik Site Administration
c. Klik User » Accounts »Add a New User
d. Klik General, isilah bagian-bagian
1) Username

2) Choose an authentication method (Cukup pilih Manual accounts)

3) New Password (min. 8 Karakter, disarankan gabungan huruf, angka dan tanda baca)

4) First name (wajib diisi)

5) Surename (wajib diisi)

6) Email address (wajib diisi)
e. Klik User picture (memasukkan gambar pada profile user/jika ada)
f. Klik tombol Create user

Account user sudah anda buat dan siap digunakan
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o Administration

v Site administration
v Users
v Accounts
% Browse list of users
£ Bulk user actions
 Cohorts
# Upload users
# Upload user pictures
> Permissions
> Courses
> Grades

> Analytics

Klik Add a New User

» General

* User picture
» Additional names
* Interests

» Optional

==

¥ Expand all

Trere are requred falgs n onis form marces @,

Gambar 9 User Baru

~ General

username @

Choase an authentication method ©

New passwerd ©

First name ©
surname @
Email address @
Email display @
Cityrown
Select a country
Timezone
Preferred language

Description ©

Gambar 10 Isian User Baru

—

Diisikan nama pengguna |

Manual accounts | | Cukup

diisikan Manual Account |

O Suspended account @
O Generate password and notify user

The password must have at least 8 characters. at least 1 digit(s). at least 1 lower case letter(s)

Click to enter tet & @

O Force password change ©

Password terdiri min dari 8 karakter,
disarankan gabungan huruf, angka dan

tanda baca

-

Nama Depan |

|

Nama Belakang |

—

Diisikan email aktif |

Allow only other course members to see my email address

Bogor

Indonesia H

Asia/jakarta

English (en) [ ]

1 A B I

E IE % % @ we

Gambar 11 Pengisian User Field
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~ User picture

Cutrent picture None

Upload foto |

O Delete picture

Maximum e size: 32MB. maximum number of fles: 1

ao

Mew pcture ©

\

You ¢an drag and drop files here to add them

Accepted file types:

mage files used O the Web g jox ey iy sy 1og

Picture descrption

» Additional names Membuat user

» Interests

» Optional

Gambar 12 Pengisian User Field

3. Pendaftaran Massal
Selain 2 jenis pendaftaran diatas, pihak admin juga dapat mengunggah user secara massal.
Cara ini digunakan jika peserta dalam sebuah pembelajaran sangat banyak, biasanya
digunakan oleh pihak admin untuk mengunggah user menggunakan format csv.
Yang harus dipersiapkan adalah:
a. Data user (dapat berupa excel)
b. Format upload data (dapat didownload di LMS) atau dapat menyesuaikan format

seperti dibawah ini:

username,firstname,lastname,email

c. Untuk mempermudah upload file diatas dapat di Save As csv di excel
d. Klik Site Administration

e. Klik User » Accounts » Upload users

f. Klik tombol Choose a file

g. Klik tombol Upload users
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&f Administration = Klik Upload users

~ Site administration
v Users
~ Accounts
£ Browse list of users
& Bulk user actions
£ Add a new user
& Cohorts
£ Upload user pictures
> Permissions
> Courses
> Grades

> Analytics

Gambar 13 Unggah Users

Upload userso Upload file csv/excel yang sudah dibuat

* Upload sesuai format diatas

Example text e

You an drag and drop fles here to 324 them

Csv ctimear N Klik Upload users ketika seluruh langkah
sudah diisi

‘Trese are required 3eids in s form martes 0.

Gambar 14 Unggah User Masal

D. Pengaturan Cohorts
Cohorts adalah salah satu fasilitas yang terdapat di LMS yang dapat digunakan untuk membagi
user menjadi beberapa kelompok. Misalkan di FEB UIKA terdapat 1.315 mahasiswa dengan 3
program studi yaitu program studi Manajemen dengan 824 mahasiswa, program studi
Akuntansi dengan 433 mahasiswa dan program studi Keuangan dan Perbankan dengan 58
mahasiswa, maka dapat dibayangkan betapa “ruwetnya” jika memasukkan user (mahasiswa)
secara manual didalam setiap course (mata kuliah). Perlunya mengelompokkan user
disesuaikan dengan tahun masuk dan kelas nya masing-masing, hal tersebut untuk
mempermudah admin/operator didalam memberikan hak akses user pada sebuah course
(mata kuliah) dengan cukup satu langkah saja dan tidak perlu memilih user secara satu-satu,

maka diperlukan pengaturan cohort.

1. Membuat Cohort
Berikut adalah cara untuk membuat cohort:

a. Klik Site Administration
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b. Klik User » Accounts » Cohorts

c. Klik Add New Cohort

d. Isikan data sesuai dengan permintaan dan kebutuhan
e. Klik tombol save changes

& Administration

v Site administration
v Users

v Accounts
£ Browse list of users
& Bulk user actions
£ Add a new user
£ Upload users

¥ Upload user pictures

/ | Klik untuk membuat Cohorts

System: available cohorts (34)

System cohorts All cohorts

Search cohort
Search

| Klik untuk membuat Cohorts

Upload cohorts

b

Gambar 15 Awal Membuat Cohort

Add new cohort

/-“ Diisikan dengan nama cohort |

Diisikan dengan Tahun
Akademik

System cohorss. All cohorts Add new cohort Upicad cohorts
Name ° MHS BARU
Context Tahun Ajaran 202002021 - GASAL / FEB
Cohort 1D MHS2020FEB
Visitle ©
owasten 137 (A~ [B 1] [=]=][%]%

Diisikan dengan nama
cohort ID

Daftar Mahasiswa FE8

Klik untuk disimpan

oo |

Gambar 16 Proses Pengisian Field Cohort
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Category: FEB: available cohorts (1)

Cohorts Add new cohort Upload cohorts

Search cohort
Search

Name Cohort ID Description Cohort size Source Edit

MHS BARU ¢ MHS2020FEB ¢ Daftar Mahasiswa FEB 0 Created manually @ o & &

Gambar 17 Hasil Membuat Cohort

Mengisi Cohort

Setelah selesai membuat cohort sesuai kebutuhan, selanjutnya adalah memasukkan data
user ke dalam cohort agar mempermudah didalam memasukkan ke dalam kelas. Berikut
adalah cara untuk memasukkan data ke dalam cohort.

a. Klik Site Administration

b. Klik User » Accounts » Cohorts

c. Klik pada Cohort yang kita buat

d. Klik icon #Assign

e. Pada bagian search, ketik data yang akan dimasukkan pada cohort

f.  Pilih lalu klik tombol Add

g. Klik tombol Back to cohotrs

. | Klik Assi
Category: FEB: available cohorts (1) —
Cohorts Add new cohort Upload cohorts
Search cohort
Search
Name Cohort ID Description Cohort size Source Edit
MHS BARU ¢ MHS2020FEB & Daftar Mahasiswa FEB 0 Created manually @ 0O & @

Gambar 18 Memasukkan Cohort
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Current users Potential users

Current users (1) Potential matching users (6)
[ iswa feb uika ika-bogor.ac.id) | fahma agnia hasanah (fahmahasanah.fh@gmail

8

Salati Asmahasanah, 5.Pd., M.Pd. (salati@uika-t
Rahma Hasanah (rahmahasanah47@gmail.cony

Setelah dipilih user yang N iswa UIKA @uika-bogor.acid
akan dimasukkan klik = — e
tombol Add
-
Remove »

Ketik user yang dicari,
disarankan menggunakan
email yang didaftarkan « B | »

Search Search| mahas

Search options »
Klik untuk kembali ke menu

Gambar 19 Proses Memasukkan Cohort

Menghapus isi search untuk
memulai pencarian baru

Category: FEB: available cohorts (1)

Jumlah user yang telah diinput
Cohorts = Addnewcohort  Upload cohorts

Search cohort

Search

Name Cohort ID Description Col size Source Edit

MHS BARU # MHS2020FEB & Daftar Mahasiswa FEB Created manually ® 0 oW

Gambar 20 Hasil Proses Memasukkan Cohort

E. Pengaturan Course (Mata Kuliah)
1. Membuat Kelas
Mata kuliah dalam LMS dapat dimasukkan ke dalam menu course, dimana didalam course
terdapat Nama Mata Kuliah, Daftar Peserta, Aktifitas Perkuliahan dan lain sebagainya. Perlu
diketahui bahwa untuk penyeragaman dan standarisasi isian telah ditentukan oleh UKSI

(Unit Komputer dan Sistem Informasi) UIKA Bogor, sebagaimana diuraikan dibawah ini:

1 Course full name Nama Mata Kuliah + (Kelas)
2 Course short name Singkatan Nama Mata Kuliah + (Kelas)
3 Ncourse ID number Tahun Akademik-FEB-Kode Mata Kuliah-Kelas

Berikut adalah cara untuk membuat course:

a. Klik Site Administration
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b. Klik Course »Add a new course

c. Pada General isikan sesuai dengan ketentuan UKSI

d. Pada Descripton isikan deskripsi singkat Mata Kuliah

e. Klik tombol Save and Display

&8 Administration

v Site administration
> Users
v Courses
€ Manage courses #nd categories
£ Add a categos

€ Add a new course

B Restore course
€ Pending requests
» Backups

> Grades

> Analytics

> Competencies

> Badges

> HSP

> Language

> Plugins

| Klik untuk membuat course (Mata Kuliah)

Klik untuk membuat course(Mata Kuliah)

Add a new course

* General

» Description

+ Course format

» Appearance

» Files and uploads

+ Completion tracking
+ Groups

* Role renaming ©

» Tags

e e J o]

P Expand al

Add a new course

~ General

Course full name @

Course short name @

Course category

Course visibility

Course start date

Course end date

Course |D number

Gambar 21 Membuat Kelas

¥ Expand all

EKONOMI BARU

Diisikan mata kuliah

EKBOO1 |

Diisikan kode mata kuliah

Tahun Ajaran 2020/2021 - GASAL / FEB

Diisikan Tahun Akademik

Diisikan Awal waktu Perkuliahan

Diisikan Akhir waktu Perkuliahan

Show #

|z1 ¢ | October & | 2020 & ] 00¢ |
|12 s February ¢ 2021 & v H Enable |
EKB001-01

Gambar 22 Proses Pengisian Identitas Kelas
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» Description

» Course format

» Appearance

» Files and uploads

» Completion tracking

» Groups

Klik untuk menyimpan data

» Role renaming o

» Tags

Soveond sl | (G

Gambar 23 Pengisian dan Penyimpan Kelas

2. Membuat Kunci Kelas
LMS memiliki fitur membuat kunci kelas, dimana fungsi ini digunakan jika user (mahasiswa)
ingin bergabung diluar waktu recruitment atau boleh dikatakan mahasiswa dapat masuk
kedalam kelas dengan sendiri.
Berikut adalah cara membuat kunci kelas:

a. Masuk menggunakan account admin/operator/dosen

b. Klik menu setting & ) more

c. Pilih Users

d. Klik Enrolment methods » Self enrolment (Student) diaktifkan dengan mengklik tanda
mata®

e. Klik setting %

f. Masukkan kunci pada bagian Enrolment key

g. Klik tombol Save changes

Setelah membuat kunci kelas, maka pada bagian course (mata kuliah) akan muncul tanda

kunci.
& cn s :
- Course administration
# Editsettings Klik Enrolment
# Turn editing off Course administration Users methods
£ Course completion Users orcledimers
Y Filters Gyoups
+ & Gradebook setup ther users
kﬂj Backup
Klik More
3 Restore Enrolment methods Manual enrolments
. 1 Import

€ Reset o
Permissions Check permissions

Gambar 24 Memulai Membuat Kunci Kelas
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#iHome @@ Dashboard  (HEvents @ MyCourses  ghyThis course

B > Courses » Tahun Ajaran 2020/2021 - GASAL > FEB > EKBOD1 > Users > Enrolment methods

Enrolment methods

Pilih Enable
Name Users Up/Down Edit

Manual enrclments 5 +
Guest access 0 ¥
Self enrolment (Student) 0 »

Add method | Choose... $

Gambar 25 Mengaktifkan Kunci Kelas

Self enrolment

Course categories:  Tahun Ajaran 2020/2021 - GASAL / FEB %
~ Self enrolment
» Expand all
Allow existing enrolments @ Yes & » Akuntansi
) Pilih Enable
Alow new enrolments @ | ves & » Manajemen
—_—
Enrolmentkey @ | ekobaru |® + Keuangan dan Perbankan
Press enter to save changes
% EKONOMI BARU aiara

Use group enrolment keys © No & Pembelajaran Ekanomi baru

Teacher: Dosen Ujicoba FEB UIKA

Gambar 26 Membuat Kunci Kelas

3. Menghapus Course (Mata Kuliah)
Adakalanya kita perlu menghapus mata kuliah yang dirasa tidak dibutuhkan. Berikut adalah
cara menghapus course (mata kuliah):
a. Masuk menggunakan account admin/operator
b. Klik Site Administration » Course » Manage courses and categories
c. Pilih Tahun Akademik » Fakultas
d. Pilih course (mata kuliah) yang akan dihapus, jika tidak menemukan mata kuliah, cukup
ketikan nama course (mata kuliah) pada bagian seach course lalu klik tombol Go
e. Checklist course (mata kuliah) » Delate » Konfirmasi penghapusan » Klik tombol

Delete

Selesai, dan course (mata kuliah) tadi telah terhapus dari LMS
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Klik v Site administration

> Users

Courses

Manage courses and categories

& Add a category
& Add a new course
& Restore course
& Pending requests
> Backups

> Grades

> Analytics

> Comoetencies

Gambar 27 Menghapus Kelas

Course and category management

Course categories
Pilih Tahun Akademik

O 4 Tal\n Ajaran 2019/2020 - GENAP

l:I 4 Tahun Ajaran 2020/2021 - GASAL I

Sonng Selecred categories *

Move selected categories to

Viewing: Course categories and courses ~

N @ ABe 0=

Gambar 28 Pemilihan Tahun Akademik

Pilih Fakultas !

+ FH

@ 8- =

® 4+ O~ =

O = FEB

0 < Akuntansi

O < Manajemen

(0 < Keuangan dan Perbankan

® 4+ 8- =

@ ¥ &~ o=

@ A ¥~ =

@ o~ =

O <+ ral

O 4+ FTs

+ FIKES

O # sps

@ 4+ Vo~ =

@ 4+ o~ o=

@ 4+ O~ o=

Gambar 29 Pemilihan Program Studi
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FEB

Create new course

Checklist MK yang akan dihapus |’ | Klik MK yang akan dihapus |

Move selected courses to...

Search courses:

Gambar 30 Check List Mata Kuliah Yang Akan Dihapus

Confirm

re you want to completely
i all the data it conta

a (MK Uji Coba) / Klik Delete

Gambar 31 Konfirmasi Pengahapusan Kelas

4. Membuat Kehadiran/Presensi Course (Mata Kuliah)
Sebagai salah satu kontrol didalam proses pembelajaran adalah, adanya format kehadiran
secara real time setiap jam perkuliahan berjalan. Sehingga mahasiswa diwajibkan untuk
mengisi kehadiran didalam setiap pertemuannya.
Berikut adalah cara membuat kehadiran/presensi course:
a. Masuk menggunakan account admin/operator/dosen
b. Pada bagian search, ketikkan nama course (mata kuliah) yang akan dibuat kehadiran
c. Klik tombol setting > turn editing on
d. Klik tanda tambah (+) Add an activity or resource
e. Pilih Attendance > klik tombol Add
f. Pada bagian General isikan sesuai perintah (misalkan KEHADIRAN KULIAH)
g. Kliktombol Save and return to course (disimpan dan kembali ke menu course awal) atau

Save and display (disimpan dan ditampilkan hasilnya)
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h. Klik Add session dan isikan sesuai jadwal kuliah

i. Pada Multiple sessions check list Repeat the session above as follows (untuk

memunculkan jadwal kehadiran sesuai dengan yang waktu mengajar sampai dengan

selesai didalam 1 (satu) semester

j.  Pada Student Recording check list Allow students to record own attendance, dan

automatic marking dipilih yes. Bagian ini digunakan agar mahasiswa dapat mengisi

secara mandiri kehadirannya dan dosen cukup memantau saja

k. Klik tombol Add

¥ v EHideblocks #f Standard viev

| Klik untuk mengaktifkan |
£ Edit settings

# Turn editing on

& Course completion |

Y Filters

& Gradebook setup

M Backup

1 Restore

1 Import 2020/2021 - GASAL
€ Reset

& More..

Gambar 32 Membuat Kehadiran Kelas

EKONOMI BARU

# Home @& Dashboard ) Events &8 My Courses &4 This course

B9 > Courses > Tahun Ajaran 2020/2021 - GASAL > FEB > EKB0O1

+ |° Announcements # Klik untuk mengaktifkan

+ Topic 1 »
- Topic 2 #

& Topic 3 »

Gambar 33 Mengaktifkan/Membuat Activity
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Add an activity or resource

—
ACTIVITIES | Klik untuk membuat kelas The attendance activity module enables a teacher to take attendance during class and students to view
o Assignment their own attenda

The teacher can create multiple

cord

ons and can mark the attendance status as “Present”, “Absent”, “Late

or "Excused” or modify 5510 Sult their needs.

Chat

Choice Reports are available for the entire class or individual students
Database

External tool

Feedback

Forum

Glossary

Jinsi

Lesson

OpenMestings

®
@
e
e
)
)
o
-
©
@
e

Quiz

Gambar 34 Pemilihan Icon Attendence

EKONOMI BA

# Home @ Dashboard 9 Events B3 My Courses & This course

B8 > Courses > Tahun Ajaran 2020/2021 - GASAL » FEB >

» General » Adding a new Attendance

o Adding a new Attendance o

b Expand al

Grade

Common module settings

Restrict access

Activity completion

Tags

Competencies

Extra restrictions

return 1o Course Save and display Cancel

Gambar 35 Membuat Kehadiran Kelas
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EKONOMI BARU

# Home @ Dashboard [ Events W MyCourses gl Thiscourse

& > Courses > Tahun Ajaran 202012021 - GASAL > FEB > EKB0O1 > General > Adding 2 new Attendance

e Adding a new Attendance o

Isid KEHADIRAN ¥ Expand all
* General | o dengon
Name @ Kehadiran

Description

T A B I EE %S @B ¢ &3 e

Kehadiran Perkuliahan

Disnlav descrintion on course page

Gambar 36 Pengisian Identitas Kehadiran

» Grade

» Common module settings
* Restrict access

+ Activity completion

» Tags

» Competencies | Simpan dan melihat hasilnya

+ Extra restrictions

o

Gambar 37 Menyimpan Pembuatan Kehadiran

EKONOMI BARU

A Home @ Dashboard Events &8 My Courses &5 This course

B5 > Courses > Tahun Ajaran 2020/2021 - GASAL > FEB > EKB0O1 > General > Kehadiran > Kehadiran

Attendance for the course :: EKONOMI BARU

Kehadiran Perkuliahan

Sessions Add session Report Export Status set Temporary users
Rl Oct19-0ct25 |d All | All past ' Months = Weeks Days
# Date Time Type Description Actions

© Choose... s

Gambar 38 Hasil Kehadiran Kelas
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Attendance for the course :: EKONOMI BARU

Sessions Add session Report Export Status set Temporary users
» Expand all
¥ Add session
Type All students
Di isikan tanggal kuliah |
Date 20  October & 2020 B3 /I | €8
Time from: 20 & 30 & Jtod 22 % 00 = /I | Di isikan Waktu Perkuliahan |
Description PR
. 1A B I EE % S @R & A ke

Kehadiran Pertemuan |

/I | Di isikan Sesi Perkuliahan |

Create calendar event for session

Gambar 39 Pengisian Identitas Kehadiran Kelas

~ Multiple sessions

= Student recording

Automatically

c."“

select highest status available

Checklist untuk pengulangan
waktu kuliah

Checklist untuk hari kuliah

Isikan waktu minggu
pengulangan

Isikan batas akhir perkuliahan

Checklist untuk mengizinkan
mahasiswa melakukan
kehadiran mandiri

Pengisian otomatis |

Tl

| Klik Add untuk selesai |

Gambar 40 Pengisian Identitas Kehadiran Kelas

5. Melihat Rekap Kehadiran/Presensi Course (Mata Kuliah)
a. Masuk menggunakan account admin/operator/dosen
b. Pada menu This course » Attendances » KEHADIRAN KULIAH

c. Pilih menu Report, disini akan terlihat kondisi kehadiran mahasiswa
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A Home @ Dashbcard &8 Wy Courses

8 > My courses » EXB00!

| Klik Attendances

untuk memulai

@ Announcements (Pengumuman)

SETIP Peserta kelas i Harus disipin 630 TepIt waktu, ma:

@ YEHADIRAN KULAH

Sianican 15 daftar kehadiran Gengan memilh P = untuk hadie

1 50h 599 & kielas dan Dak ks untu

Gambar 41 Memulai Rekap Hadir

Attendance |

Klik KEHADIRAN KULIAH

Topic

General

Gambar 42 Menu Kehadiran

Attendance for the course :: EKONOMI BARU Klik tanda panah

Silahican isi daftar kehaciran dengan memilih 9 = untuk hadis

Reguiar class session

Sheors. d -

Gambar 43 Membuat Kehadiran

Attendance for the course :: EKONOMI BARU

SAahian @ Cattar kehadiran Cengan memih P = untuk had

- . wnsse e -
Users=
Sessionsd
First narme / Surname o2t
10AM
Emad address ey
maharsaafebuks  MAstebOfeuika-bOgOrICId en i
Mahassuwa UKA mahasIwa SR bogor aC.id
ahasswa ted | Uka  emaADganticom

gantSgant
wmmary Present 1
Late
Excused: O
Absent
Users: 4

e
00

0 100.0%
° 0 v
[ 0 ° 2.0

Gambar 44 Tampilan Kehadiran Kelas
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6. Mengekspor Kehadiran/Presensi Course (Mata Kuliah)
a. Masuk menggunakan account admin/operator/dosen
b. Pada menu This course » Attendance » KEHADIRAN KULIAH
c. Pilih menu Export (pilihan format bisa dalam bentuk excel)

d. Klik tombol OK

Export

Gambar 45 Eksport Kehadiran Kelas

7. Mengatur Settingan Kehadiran/Presensi Course (Mata Kuliah)

a. Masuk menggunakan account admin/operator/dosen

b. Pada menu This course » Attendance » KEHADIRAN KULIAH

c. Pilih menu Status set, disini secara default terisi P untuk Present (Hadir), L untuk Late
(Terlambat), E untuk Excused (lzin) dan A untuk Absent (Tidak Hadir). Data tersebut
bisa diganti menggunakan bahasa Indonesia H untuk Hadir, T untuk Terlambat, | untuk
Izin dan A untuk Alpa/Tidak Hadir (disesuaikan dengan kebutuhan). Sedangkan untuk
settingan Availabe for students (minutes) membatasi waktu pengisian. Serta untuk
Automatically set when not marked, bagian mana yang akan otomatis tertandai jika
tidak diisi.

d. Klik tombol Update
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Attendance for the course :: EKONOMI BARU

. Acronym Description Points

Available for students (minutes) § Automatically set when not marked ©

Gambar 46 Pengaturan Kehadiran Kelas

F. Pengaturan User

1. Memasukkan Peserta Kelas

Untuk memasukkan data user kedalam kelas terdapat beberapa jenis, diantaranya yaitu:

Secara manual

Cara ini memasukkan user di enrol satu-persatu, berikut adalah cara memasukkan data

user secara manual:

1) Masuk menggunakan account admin/operator/dosen
2) Cari course (mata kuliah) yang akan di upload user

3) Klik This course » Participants

4) Klik tombol Enrol users

5) Pada bagian kolom user diketikkan nama user

6) Pada Assign role pilih Student untuk user mahasiswa dan Teacher untuk user Dosen

EKONOMI BARU

# Home @ Dashboard £ events &8 My Courses

= Sections
B > Courses > Tahun Ajaran 2020/2021 - GASAL > FEB > EKBOOT *— "
BB Grades
@© Announcements (Pengumuman) "
@ Assignments

Setiap peserta kelas ini harus disiplin dan tepat waktu, max 1(

LMsS

@ Auendances
daftar hadir

@ Forums
© KEHADIRAN KULIAH ® Lessons
Silahkan isi daftar kehadiran dengan memilih P = untuk hadir @ Resources

4 | Klik Participants untuk memulai

Gambar 47 Memasukkan Perserta Kelas
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# Home @ Dashboard 4 Events &8 My Courses &&aThis course

&5 > Courses > Tahun Ajaran 2020/2021 - GASAL > FEB > EKBOO1 > Participants

Klik Enrol users untuk |
P memasukkan peserta
Participants P

No filters applied

Enrol users
yword or select filter ¥

Search ke

Number of participants: 0

First name A|BIC|D|EB|F|IG|H|I|)IK MIN O P
Surname alslc|o|e|le|le|u|i|)|k|e|m]|nlo|e|lq|r|s]|T
Nothing to display

+ With selected users..,

Proceed to course content Enrol users

Gambar 48 Proses Memasukkan Peserta Kelas

Enrol users ®
Enrolment options
Input data mahasiswa, disaran
Select users No selection menggunakan email
Select cohorts No selection
= Pilih Student untuk user
peserta/mahasiswa
Assign role Student :
Show more...
Klik selected untuk memasukkanl l\
== e
Gambar 49 Memasukkan Data Peserta Kelas
Enrol users ®
Enrolment options
Select users No selection

mahas b

fahma agnia hasanah fanmahasanah fm@gmail.com =

| Pilih user yang ingin dimasukkan
Select cohorts

Salati Asmahasanah, 5.Pd., M.Pd. satati@uika-bogor.acid

. mahasiswa feb uika mhsfeb@fe.uika-bogor.acid

Assign role Rahma Hasanah rahmanasanandi?@gms

Show more... Mahasiswa UIKA mahasiswa@uika-bogor.ac.id

Enrol selected users and cohorts

Gambar 50 Pemilihan Peserta Kelas
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Enrol users ®
Enrolment options

Select users

X Yudiana, SE., M.M. emaiis2ganti@uika-bogor acid

Select cohorts No selection

Enrol selected users and cohorts

Gambar 51 Pemilihan Role Peserta

1 enrolled users

Participants

No filters applied
Enrol users
Number of participants: 1
First name m A B
Surname m A B

Firstname “ /Surname Email address Roles Groups Last access to course Status

email52ganti@uika-bogor.ac.id Teacher & No groups Never mﬁ & 8

Gambar 52 Hasil Input Peserta Kelas

Secara massal menggunakan fungsi cohort
Memasukkan data user secara manual akan menjadi tidak efektif dan efisien jika jumlah
user amat sangat banyak, setelah kita memiliki cohort (dapat dilihat pada bagian
pembahasan cohort) akan sangat membantu didalam memasukkan data user kedalam
course (mata Kuliah).
Berikut adalah cara memasukkan data secara masal:
1) Masuk menggunakan account admin/operator/dosen
2) Cari course (mata kuliah) yang akan di upload user
3) Klik This course » Participants
4) Klik tombol Enrolment option pilih nama cohort yang sdh kita buat
5) Asign Role dipilih Student untuk mahasiswa

6) Kllik tombol enrol selected user and cohort
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Enrol users

Enrolment options

Select users

Select cohorts

Assign role

MESY Ganjil 2020-2021-REG3

MHS BARU

No selection

Pilih Cohort yang ingin

N ! n i
0 selectiol dimasukkan

v

Show more...

MM Ganjil 2020-2021

Enrol selected users and cohorts

Enrol users

Enrolment options

Select users

Select cohorts

Assign role

Gambar 53 Pemilihan Peserta Cohort

®

Tampilan Cohort yang ingin
dimasukkan

No selection

Pilih role “Student”

Student

Show more...
Enrol selected users and cohorts
Gambar 54 Pemilihan Peserta dan Role Cohort
Participants
No filters applied
Enrol users
t v
Number of participants: 5
F»rs(namem;g ciplelFlG|H ) K N P|Q|R|S|T|U z
Sufna"‘em;sczgzg_ K LA o P QlrsS T U z
Firstname “ /Surname Email address Roles Groups Last access to course  Status
0 - - - - - -
(m] mahasiswa feb uika mhsfeb@fe.uika-bogor.ac.id Student##  No groups Never n (i -2 - |
] Mahasiswa UIKA mahasiswa@uika-bogor.ac.id Student#*  No groups Never | acve IE-0 -
) mahasiswa feb 1 uika bogor  email@ganti.com Student#  Nogroups Never Ejo s
0 mahasiswa feb 2 uika bogor  ganti@ganti.com Student#  No groups Never m (i - - |
(m] Yudiana, SE., M.M. emailS2ganti@uika-bogor.ac.id  Teacher # Nogroups Never m oo n

Gambar 55 Hasil Cohort

2. Menghapus Peserta Kelas

Adakalanya data/user yang dimasukkan kedalam LMS sudah tidak dibutuhkan lagi atau

mungkin terjadi salah unggah (upload), maka diperlukan untuk memperbaiki ataupun
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menghapus data yang ada. Berikut adalah cara untuk menghapus user di course (mata
Kuliah)

a. Masuk menggunakan account admin/operator/dosen

b. Cari course (mata kuliah) yang akan di upload user

c. Klik This course » Participants

d. Check List user yang akan dihapus, pilih unenrol

e. Klik tombol unenrol

Selesai dan data user sdh tidak terbagung kembali di course (Mata kuliah)

B > Courses > Tahun Ajaran 2020/2021 - GASAL > FEB

Course categories:  Tahun Ajaran 2020/2021 - GASAL / FEB B

Pilih Mata Kuliah

» Akuntansi
» Manajemen

» Keuangan dan Perbankan

%* EKONOMI BARU Pembelajaran Ekonomi baru

Teacher: Yudiana, SE., MM.

% MK Uji Coba

Add a new course Courses pending approva

Gambar 56 Pemilihan Mata Kuliah Yang Akan Dihapus

EKONOMI BARU e

4 Home @ Dashboard [ Events @ MyCourses  gfyThis course

B5 > Courses > Tahun Ajaran 2020/2021 - GASAL > FEB > EKBOO1

| ° Announcements
Topic 1

Topic 2

Gambar 57 Memulai Kelas
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B > Cour > Tahun Aja 20/202 ASAL > FEB > EKB0O1 > Participants

Participants

No filters applied Checklis peserta yang akan Klik icon “Tong Sampah” untuk s
dihapus menghapus !
v
Number of participants: 5
First name
Surname m
Firstname = /$fmame Email address Roles Groups  Lastaccess to course
uika mhsfeb@fe.uika-bogor.ac.id Student & No groups  Never
mahasiswa@uika-bogor.ac.id Student # Nogroups  Never

Unenrol
Pilih Unenrol untuk menghapus

Do you 1t to unenrol "Yudiana, SE., M.M."

al enrolments”) from "EKONOMI BARU"?

I Unenrol I

Cancel

Gambar 59 Konfirmasi Penghapusan Peserta

3. Memasukkan Peserta Sementara
Memasukkan peserta sementara biasa digunakan pada saat tertentu, misalkan mahasiswa
yang mengikuti remedial (perbaikan) sedangkan untuk mahasiswa mengulang sudah harus
melakukan kontrak studi di SIAK. Berikut adalah cara memasukkan user sementara:
a. Masuk menggunakan account admin/operator/dosen
b. Pada menu This course » Attendance » KEHADIRAN KULIAH
¢. Pilih menu temporary user, isikan Full Name dengan nama lengkap dan Email yang

masih berlaku

d. Klik tombol Add user

Temporary users : EKONOMI BARU

Sessions Add session Report Export Status set Temporar

- Add temporary user
Isi dengan Nama Lengkap
Full name @

Isi dengan email

Add user Ass user untuk menambah user

Temporary users

Gambar 60 Memasukkan Peserta Sementara
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G. Pengaturan Profil

Pada setiap account LMS setiap user dapat melakukan pengeditan profil, melihat course (Mata

Kuliah) yang diikuti/diajarkan dan masih banyak lagi. Untuk melakukan pengeditan user dapat
melakukan sebagai berikut:

1. Masuk menggunakan account yang sudah dimiliki
2. Klik pada bagian menu identitas nama

3. Pilih View profile, silahkan lakukan pengeditan profil

A English (en) = Dosen Ujicoba FEB UIKA

Learning Management System of UIKA Bogor — ESEmmmmpesen

& View profile

% Edit profile View profile
#A Home @@ Dashboard @ Events &% My Courses Customise this page =1 ew
@ Grades
ANNOUNCEMENTS TGGERRTEE Klik View profile | # Preferences

9 Calendar
= Recently accessed courses & Navigatiol ® Logout
@ Dashboard

# Site home

> Site pages
R . v My courses
INO recent courses
> EKBOO1
= Course overview o
A Timeline F
Y All (except removed from view) ~ m 3

Gambar 61 Memulai Pengeditan Profil

About me Courses More
ii General
Kik Edit profile ||[2©S€N Ujicoba FEB
UIKA

Description 12

Qreferences

3 Av | B | I | =|&E|| %S
Edit profile
dosen@gantimail.com BB ¢ @

Gambar 62 Tampilan Profil
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User picture

Current
picture

None

Upload Foto

New picture 2]

MaXmum file size: 32MB, maximum number of files: 1

™ Fles

-

You can drag and drop files here to add them.

Accepted file types:

Image files used on the web

Gambar 63 Memasukkan Gambar Profil

File picker

h Recent files

&4 Upload a file

& URL downloader

Upload Foto

Attachment
T Private files

Choose File |No file chosen

) Wikimedia
Save as

Author

Dosen Ujicoba FEB UIKA

Choose license

o

All rights reserved

Upload this file

Gambar 64 Memilih Foto Profil

a»

dosen.png

Accepted file types:

Image files used on the web

Picture description Klik untuk Update Foto

Update profile
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Gambar 65 Memasukkan Foto Profil

B > Profile

1 Courses More Edit profile

- Description
Dosen UJ|COba FEB Saya adalah dosen FEB yang mengajar MK in
e Ser yang mengajar ini
UIKA
Interests
Preferences
Membaca
Edit profile

dosen@gantimail.com

Gambar 66 Hasil Update Gambar Profil

A Home @ Dashboard Events &8 My Courses

B > Profile

A,' About me More Edit profile
o (s

) TV 4
Dosen Ujicoba FEB Course profiles
UIKA EKONOMI BAR

Preferences
Edit profile

dosen@gantimail.com

Gambar 67 Profil Mata Kuliah Yang Diajar

H. Pengaturan Course (Mata Kuliah)
Setelah memiliki account dan melakukan pengeditan profil, user dapat melakukan pengaturan
course (mata Kuliah) bagian ini khusus untuk admin/operator dan dosen atau user yang

memiliki hak akses pengaturan.

Untuk membuat penambahan kegiatan didalam course dapat dilakukan dengan mengaktifkan
fitur yang ada di menu Add an activity or recources, berikut adalah cara mengaktifkan fitur
tersebut:

1. Masuk menggunakan account admin/operator/dosen

2. Klik Action menu » Turn editing on

3. Klik Edit » Edit settings
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4. Klik tanda + (plus) Add an activity or resource

Klik untuk Turn editing on

£ Editsetntings

Turn editing on

Course completion
Filters

Gradebook setup
Backup

Restore

Import

Reset

S » » = B & 4 SN

More...

Gambar 68 Mengkatifkan Pengaturan Course

B > Mycourses > EKB0O!
Klik untuk Add

a
‘

+

@ Announcements (Pengumuman) # Edit

Setiap peserta kelas ini harus disiplin dan tepat waktu, max 10 menit sebelum perkuliahan sdh siap di kelas dan tidak lupa untuk mengisi daftar hadir

+ @) KEHADIRAN KULIAH #

Silahkan isi daftar kehadiran dengan memilih P = untuk hadir

+ Add an activity or res

Gambar 69 Memulai Pengaturan Course

Add an activity or resource

ACTIVITIES
Assignment
Attendance
Chat
Choice

Database

External tool

s may be used

Feedback
. Fo directed learning o
Forum . or simulations/decision-makin
Glossary . ated revision, with different set 1g UpON answers given to
Jitsi
. Lesson o

OpenMeetings

PP v000QROPD000

Quiz
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SCORM package

00

)
o]
]

Q00600000
e

Gambar 70 Pengaturan Aktifitas Kuliah

1. Membuat Pengumumam
Pada bagian ini dosen dapat memberikan pengumuman atau RPS kepada peserta Mata
Kuliah. Berikut adalah cara membuat pengumuman di course
a. Masuk menggunakan account admin/operator/dosen
b. Klik Action menu » Turn editing on
c. Klik Edit » Edit settings

d. Klik tanda + (plus) Add an activity or resource

P ey L Klik Edit Settings

+

@ Announcements (Pengumuman) #

Setiap peserta kelas ini harus disiplin dan tepat waku, max 10 menit sebelum perkuliahan sdh siap di kelas dan tidak lupa untuk m

* (@) KEHADIRAN KULIAH #

Silahkan isi daftar kehadiran dengan memilih P = untuk had

Gambar 71 Pengaktifan Aktifitas
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~ General
Forum name o Announcements (Pengumuman)
Description pray 7=
INA> | B|Tli=EMS
Setiap peserta kelas ini h
Display description on course page ©
Forumtype @ Announcements
» Availability

» Attachments and word count

arus disiplin dan tepat waktu, max 10 menit sebelum perkuliahan sdh siap di

aftar hadir di LMS

Judul Pengumuman

o B 0w P ke

Isi Pengumuman

Subscription and tracking

Discussion locking

Post threshold for blocking

Whole forum grading

Ratings

Common module settings

Restrict access

Activity completion

Tags

Competencies

| Menyimpan Pengumuman

There are required fields in this form marked @

Gambar 72 Pengaturan Konten Pengumuman

% > Mycourses > EKBOO1 > General > Announcements (Pengumuman)

Announcements (Pengumuman)

Setiap peserta kelas ini harus disiplin dan tepat waktu, max 10 menit sebelum perkuliahan sdh siap di kelas dan tidak lupa untuk mengisi daftar

hadir di LMS

Add a new topic

(No announcements have been posted yet.)

Gambar 73 Hasil Pembuatan Pengumuman

2. Membuat Materi Kuliah

Untuk menambahkan kegiatan mengajar atau membuat materi perkuliahan, dosen dapat

menggunakan fitur Lesson, sebagaimana cara dibawabh ini:

a. Masuk menggunakan account admin/operator/dosen

b. Klik Action menu » Turn editing on

c. Klik Edit » Edit settings
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d. Klik tanda + (plus) Add an activity or resource

e. Pada Activities » Lesson

Add an activity or resource a
° As
@ «
. ch
@ «
@ owas
Q
© Klik Lesson untuk
® - membuat Materi
& s pag
@ opn
® o=
© sconn;
[ oo I cnat |
Gambar 74 Membuat Materi Kuliah
» Adding a new Lesson to Topic 1o
P Expand al

Name @ Pengantar Teori Ekonomi Baru

Description 1 A B I EIE % S DB 4 ™3 w

rpertemuan / Penjelasan Materi

| -

Display description on course page @

» Appearance

» Availability

Gambar 75 Proses Pengisian Identitas Mata Kuliah

Pengantar Teori Ekonomi Baru @

Bagian ini digunakan untuk menyampaikan materi perpertemuan
review Edit Reports Grade essays
Collapsed  Expanded

What would you like to do first?

Import questions

Gambar 76 Hasil Pembuatan Materi Kuliah
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3. Mengunggah (Upload) Materi Mengajar

Untuk menambahkan kegiatan mengajar atau membuat materi perkuliahan, dosen dapat

menggunakan fitur Lesson, sebagaimana cara dibawah ini:

a.

b.

Masuk menggunakan account admin/operator/dosen
Klik Action menu » Turn editing on

Klik Edit » Edit settings

Klik tanda + (plus) Add an activity or resource

Pada resources » File

o Adding a new File to Topic 1

me @

b Expand

Description 1 A B I EE % S

5}

B w B e
/ Penjelasan Materi

Klik File untuk unggah

Maximum size for new files: 32M

Gambar 77 Proses Unggah File

File picker al

184

. Klik Choose File untuk | # & =
#h Recent filk unggah

/]

»
Choose File | o f

Upload this file

Gambar 78 Pemilihan File Yang Akan Diunggah
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@ Open x

« “ 4 1 > OneDrive - Per.. > Documents > v U Search Documents P |irse=29328section=1&retum=0&sr=0

Organize ~  New folder - m @
@ OneDrive - Person A Name Status Date mo - ;
& 10-
Bahan Latihan _‘1 foto mhs 16-10-20 @ 16/10/2( P e Vangha an
- ungga
BROADCAST & peserta @ 16/10/2( 88
N DESIGN PAJAK [ 710/2(
x o] 15/10/2(
Email attachmen’ [©) 1471072
KULIAH @ 14/10/2(
LMS MODUL @ 13/10/2(
Pictures 1 Sandi aplikasi windows o) 1710720 v
v < >
File name: | Pengantar Ekonomi Baru | Al Files B
Conce
Author

Dosen Ujicoba FEB UIKA

Choose license

All rights reserved 2

Gambar 79 Pilih File yang Akan Diunggah

File picker
 Server files H OE @
h Recent files
& URL downloader
Choose File | Pengantar Ex..| Baru.docx
#n Private files
Save as
9 Wikimedia
Author
Dosen Ujicoba FEB UIKA
Choose license
All rights reserved z
Name @ Pengantar Ekonomi Baru
besrtption 1 A B I EIE %% @B & % we
Penjelasan Singkat Mata Kuliah
@ Display description on course page ©
Select files Maximum size for new files: 32M8B
o) =00
- e
2y

Pengantar Ek.

» Appearance
» Common module settings

» Restrict access

b Artivitvg ramnlatinn

Gambar 80 Tampilan Unggahan Materi Kuliah
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Edit Pengantar Ekonomi Baru.docx

Pengantar Ekonomi Baru.c

Auth
uthor Dosen Ujicoba FEB UIKA

Choose license
All rights reserved B
Other

All rights reserved
Public domain
Creative Commons

Creative Commons - NoDerivs

Creative Commaons - No Commercial NoDerivs
Creative Commons - No Commercial

Creative Commaons - No Commercial ShareAlike
Creative Commons - ShareAlike

Path

Last mi

(ﬁ Sze 136@

Oczober 2020, 9:18 PM

Gambar 81 Jenis Materi Unggahan

EKONOMI BARU

# Home @ Dashboard g Events & My Courses &l This course

B > Mycourses > EKBOO1 > Topic1 > Pengantar Ekonomi Baru

Pengantar Ekonomi Baru
Penjelasan Singkat Mata Kuliah

Click Pengantar Ekonomi Baru.docx link to view the file.

PREVIOUS ACTIVITY

“ KEHADIRAN KULIAH

Jump to... s

EKONOMI BARU

# Home @ Dashboard £ Events &8 My Courses & This course

& > Mycourses > EKBOO1

Edit ~

+ |° Announcements ¢ Edit v &
+
@ KEHADIRAN KULIAH & Edit > & &

Silahkan isi daftar kehadiran dengan memilih P = untuk hadir
+ Add an activity or resource
Topic 1 # Edit ~
+

& @ Pengantar Ekonomi Baru ¢ Bt &

Penjelasan Singkat Mata Kuliah

Masuk ke Spada + Add an activity or resource

Gambar 82 Hasil Akhri Unggah Materi
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4. Membuat Penugasan/Ujian
Untuk menambahkan kegiatan mengajar atau membuat penugasan/ujian, dosen dapat
menggunakan fitur Assignment, sebagaimana cara dibawabh ini:
a. Masuk menggunakan account admin/operator/dosen
b. Klik Action menu » Turn editing on
c. Klik Edit » Edit settings
d. Klik tanda + (plus) Add an activity or resource

e. Padaresources » File » Assignment

Add an activity or resource a

Pilih untuk membuat

penugasan/ujian

e -
® « i
@» ch

@ o

®

o F

‘ For o
@ cos

S s

@ ‘Lesson

@ O

@ o

@ sCcorM package

?

Gambar 83 Membuat Penugasan/Ujian

EKONOMI BARU

#Home  @Oashboard  [MEvents @M MyCourses g8 This course
B > Mycourses » EKI 3 Topic1 > Adding a new Assignment to Top
@ Adding a new Assignment to Topic 1 ¢ Isi Judul Tugas
= General
My e 0 I
1 A* B I EE % S

Isi Deskripsi Tugas

Gambar 84 Memulai Pengisian Penugasan/Ujian
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Tanggal Memulai
Penugasan/Ujian
~ Availability |

|Al owsubmissionsfrom @ 206 | Ocober & | 20208 || 00® | 00 ¢ ) @enoble Tanggal Akhir
Penugasan/Ujian

| Due date @ 27¢| ocober & 2020¢ 00¢ 00¢ {4 Benable Mermbatasi 'Il'anggal

| Cutoff date © . - = . B & Oenanie Akhir Penugasan/Ujian

Remindmetogradety © | 3 o || November o || 20209 || 000 || 00 s | 8 Benable

Always show description ©

~ Submission types

Submission types Online text ©@ File submissions ©

Maximum number of uploaded files @ 0¢

Jenis File yang dapat di

Maximum submission size @ Site upload limit (32M8) &

unggah

Accepted file types ©@

» Feedback types
» Submission settings
» Group submission settings

» Notifications

Gambar 85 Proses Pengisian Penugasan/Ujian

Accepted file types @
£ All file types -
00 Archive files 7z doc cdoc ddoc grar 152 g2 g2ip b ror 3¢ tae 20

E

) Audio files ssc s 8iff sifc au fisc m3u.mpd mia ogs 088 r8 rem .
-
O Audio files natively supported by browsers .ssc fac ma3 mia oga
ogg v

) Audlo files used on the web ssc flac mo3 més oga ogs ra sae

O Document files .doc dacx epub goc ot .om oth pdf rif Expard

Save changes

Gambar 86 Jenis Unggahan Penugasan/Ujian

* Common module settings

availability @ Show on course page ¥
0 number @
Group mode @ No groups s

Add group/gr

~ Restrict access Memasukkan

Access restrictions Pembatasan Penugasan
None

» Activity completion
» Tags

» Competencies

There are required fields in this form marked @,

Gambar 87 Memasukkan Pembatasan Penugasan/Ujian
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Add restriction Penugasan/Ujian

Pembatasan Tanggal Publish

Activity completion

eI
Cnde Require students to achle

User profile ontrol access based on field: the student's profile.
Restriction set Add 3 set of nested restrictions to apply complex 10g

Gambar 88 Jenis Pembatasan Penugasan/Ujian

0 Y events @ MyCourses  aThi

EKONOMI BARU

B8 > Mycourses » EKBOO1 » Topic1 > Penugasan Pertemuan 1
Penugasan Pertemuan 1

Berikan ringkasan tentang pentingnya ekonomi baru di masa pendemi covid 19
Grading summary

Hidden from students. No
Participants

Submitted

Needs grading 0

Due date 12:00 AM

Time remaining

View all submissions | Grade

Gambar 89 Tampilan Penugasan/Ujian

5. Mengisi Daftar Hadir (Presensi) Perkuliahan

Daftar hadir yang disediakan oleh LMS hanya tersedia bagi mahasiswa/peserta perkuliahan,

untuk mengisi kegiatan perkuliahan, maka mahasiswa perlu mengisi sebagaimana cara

dibawah ini:

a.

b.

Masuk menggunakan account user
Klik My Courses menu » Pilih Mata Kuliah

Klik Submit Attendance

Pilih P = Present (Hadir), L = Late (Terlambat), E = Exuced (Izin), A = Absent (Tidak Hadir)

# Home @ Dashboard 4 cvents

&8 My Courses

EKB001
B > Courses > Tahun Ajaran 202072021 - GA

Course categories:

Tahun Ajaran 2020/2021 - GASAL

Gambar 90 Pemilihan Mata Kuliah Kehadiran
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KEHADIRAN KULIAH
Silahkan isi daftar kehadiran dengan memilih P = untuk hadir

This course All courses

TTkiik untak mengisi
kehadiran

Date Description Status Points
Wed 21 Oct 2020  Regular class session Submit attendance
10AM - 11:40AM

Taken sessions:0
Points over taken sessions:0/ 0
Percentage over taken sessions:0.0%

Gambar 91 Submit attendance Untuk Mengisi Kehadiran

| My courses > EKBOO1 > General > KEHADIRAN KULIAH > KEHADIRAN KULIAH

~ 21 October 2020 10AM kehadiran

mahasiswa feb uika: @ | ®Present Late Excused Absent

£33 e

There are required fields in this form marked @

NEXT ACTIVITY

Pengantar Teori Ekonomi Baru

»

Jjump to s

Gambar 92 Pemilihan Kehadiran

| 38 My courses > EKBOO1 > General > KEHADIRAN KULIAH > Attendance report

Your attendance in this session has been recorded. X

KEHADIRAN KULIAH
Silahkan isi daftar kehadiran dengan memilih P = untuk hadir

hiscourse Al courses
Bl October [3 All || All past | Months | Weeks || Days

Date Description Status Points Remarks

"
"~

Wed 21 Oct 2020  Regular class session Present Self-recorded

10AM - 11:40AM

Taken sessions: 1
Points over taken sessions:2 / 2
Percentage over taken sessions: 100.0%

Gambar 93 Hasil Kehadiran Kuliah

6. Mengunduh (Download) Materi/Tugas Perkuliahan
Untuk mengunduh untuk materi/tugas bagi mahasiswa/peserta perkuliahan, sebagaimana
cara dibawah ini:
a. Masuk menggunakan account user

b. Klik My Courses menu » Pilih Mata Kuliah
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c. Klik Materi kuliah (file otomatis terdownload)

Learning Management System of UIKA Boao

Pilih Mata Kuliah

4 Home @ Dashboard &8 My Courses

£ events

EKBOO1
ANNOUNCEMENTS undefined
[
aRU |

T ERORORT

Gambar 94 Memilih Mata Kuliah Unduhan

@) KEHADIRAN KULIAH

Silahkan isi daftar kehadiran dengan memilih P = untuk hadir
Topic 1

& Pengantar Teori Ekonomi Baru

@ Not attempted

Bagian ini digunakan untuk menyampaikan materi perpertel
Pilih Mata Kuliah
| @ File Materi Ekonomi Baru

Penjelasan Singkat Mata Kuliah

@ Penugasan Pertemuan 1

© Not Submitted
Due 27 October 2020

Berikan ringkasan tentang pentingnya ekonomi baru di masa pendemi covid 19

Gambar 95 Materi Siap Diunduh

7. Mengunggah (Upload) Tugas/Ujian Perkuliahan
Untuk mengunggah (Upload) untuk tugas/Ujian bagi mahasiswa/peserta perkuliahan,
sebagaimana cara dibawah ini:
1. Masuk menggunakan account user
2. Klik My Courses menu » Pilih Mata Kuliah

3. Klik Penugasan

Learning Management System of UIKA Boao

Pilih Mata Kuliah

# Home @ Dashboard 4 events &= My Courses

EKB0O1
ANNOUNCEMENTS undefined
RORT a;ﬁul

Gambar 96 Pilih Mata Kuliah Penugasan/Ujian
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@ KEHADIRAN KULIAH

Silahkan isi daftar kehadiran dengan memilih P = untuk hadir

Topic 1

@ Pengantar Teori Ekonomi Baru

O Not attempted

Bagian ini digunakan untuk menyampaikan materi perpertemuan

0 File Materi Ekonomi Baru

Penjelasan Singkat Mata Kuliah

I @ Penugasan Pertemuan 1

@ Not Submitted

Due 27 Ocrober 2020

Berikan ringkasan tentang pentingnya ekonomi baru di masa pendemi covid 19

Penugasan Pertemuan 1

Berikan ringkasan tentang pentingnya ekonomi baru di masa pendemi covid 19

Submission status

Submission status
Grading status
Due date

Time remaining
Last modified

Submission
comments

Gambar 97 Klik Mata Kuliah Penugasan/Ujian

No attempt
Not graded
Tuesday, 27 October 2020, 12:00 AM

5 days 13 hours

» Comments (0) /{ Unggah Penugasan

You have not made a submission yet.

—1

Penugasan Pertemuan 1

Berikan ringkasan tentang pentingnya ekonomi baru di masa pendemi covid 19

File submissions

Gambar 98 Unggah Penugasan/Ujian

Maximum file size: 32MB, maximum number of files: 2C

~

You can drag and drop files here to add them.

Cancel

Gambar 99 Memilih File Yang Akan Diunggah
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File picker

h Recent files

E m

4 Upload a file
Th Private files

Attachment

) Wikimedia
| Pilih File | Tugas 1 Fulan.doex
Save as
Author

mahasiswa feb uika
Choose license

All rights reserved :

Upload this file

Gambar 100 Menggungah File Penugasan/Ujian

Penugasan Pertemuan 1

Berikan ringkasan tentang pentingnya ekonomi baru di masa pe

[OFc R4 ol = 1~
-

Klik save untuk
menunggah file

(™

i

Save changes

Gambar 101 Menyimpan Penugasan/Ujian

Penugasan Pertemuan 1
Berikan ringkasan tentang pentingnya ekonomi baru di mass pendemi covid 19

Submission status

Submission status  Submited for grading

Grading status Not graded

Due date Tuesday, 27 October 2020, 12:00 AM
Time remaining 5 days 13 hours

Last modified Wednesday, 21 October 2020, 10:38 AM

File submissions
@© Tugas 1 Fulan.doc 21 October 2020, 10:38 AM

Submission
comments B Gomments (0)

Gambar 102 Hasil Unggah Penugasan/Ujian

8. Mengelola Hasil Tugas/Ujian Perkuliahan

Untuk mengelola hasil untuk tugas/Ujian bagi mahasiswa/peserta perkuliahan,

sebagaimana cara dibawah ini:
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Masuk menggunakan account user
Klik My Courses menu » Pilih Mata Kuliah
Klik Penugasan/Ujian

Klik View all submissions

Penugasan Pertemuan 1

Berikan ringkasan tentang pentingrya ekonomi baru di masa pendemi covid 19
Grading summary
Hidden from students No
Participants. 4
Submitted 1
Needs grading 1
Due date

Time remaining Assignment is due

Tuesday, 27 October 2020, 12:00 AM

View all submissions

Gambar 103 Memulai Pengaturan Tugas/Ujian

st
User  Firstname modiied
select  pkture  /Surname

Emad address Status Grade Edit

marasiswa@uis- N
Bogor.acia

fsubmission)  File submissions

| i yang Commenss
dikumpulkan|

Last
Submission  modified Feedback
comments  (grade) comments  Final

Tugas/Ujian

I © Tupas 1 Fusn

ermai@ganticom  No Ed
submissien
ganc@ganticom  No Grade £
submissien
Graded 30.00
‘
Wi selected Lock submissior : I
Options
Assignmaenss par page 10 ¢
Filtes No fiter *

Gambar 104 Pengisian Tabel Penugasan/Ujian
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Check list untuk download materi, dapat dilakukan
secara masal dengan checklist select di judul

10:38 AM

Pilih untuk
download materi

~ Options

Gambar 105 Unduh Hasil Penugasan/Ujian

elearning.uika-bogor.ac.id menyatakan

Download selected submissions?

o

Gambar 106 Konfirmasi Unduhan

@ Savers X
2 > ThisPC > DATA(D) > v n
Organize »  New foider - 0
B This PC S Nome Date ype
2 30 Objects AKA e folde
B Desitop DATA LAMA Ide
3 Documents DESEN 2020 1824 e folde
$ oon DOSEN 5/08/2020 20,54 File folde
Plos MY DATA
D Music 0BS
& Pictures @ Onedrive 2020 09.24 Fie folde
B Videos UMUM 2 2020 1 F ;
S Local Disk (C:) B £KBOO1-Penugasan Pertemuan 1-14358
—0AmD) N
[T X5001-Penugasan Petemusn 1-
Save as type: | WinRAR ZIP archive v
~ WdeFoiden =

Gambar 107 Menyimpan Hasil Unduhan

9. Mengekspor Hasil Tugas/Ujian Perkuliahan

Untuk mengekpor hasil untuk tugas/Ujian bagi mahasiswa/peserta perkuliahan,
sebagaimana cara dibawah ini:
a. Masuk menggunakan account user

b. Klik My Courses menu » Pilih Mata Kuliah

c. Klik This course » Grades

A Home @® Dashboard m Events -m

-_ . . EKBOO1

Gambar 108 Memilih Mata Kuliah Yang Akan Di Ekspor
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o3 This course

i= Sections

& Participants

BB Grades (

Assignments

Forums

®
@ Attendances
(-]
@

Lessons

@ Resources

Gambar 109 Pemilihan Grades

Grader report Graer repart .
View | Seup  Scakes  Lemers Pilih Export
Graderreport  Gredehisiory  Ouiomesrepart  Overviewreport  Singleview  User report

All participants: 4/4

Fms:-a're-,.g colEF G H kLt M[nore|lafnsir|uve

Su-uw, 8 CD0EFG N kL ulnjelse st

EKONOMI BARUC

First name / Sumame &

matasseateouia @ #

Email address

minsfeote uika-bagor.acid

100.00

@ [Deetoninprogess]ke # # @ KEHADRANKULAH & # @ [DeietoninprogressiTe.. & # @ Penganar Teod Bonomi. & # @ PerugesanPememuan 1 8 /'

a 8000
Minesises UKA [ 4  monasiswaBuika-begoracid a
manasises fes 1 uika
ranasisea feo Y — . . . a 3000
bogor
uhmses b 2uka | @ o | gaegentcon 5 5 5 a 3000
boger
Overat average . 10000 667

Gambar 110 Tampilan Tabel Grader

Export to OpenDocument spreadsheet

View Setup Scales Letters Import Export

OpenDocument spreadsheet Plain text file Excel spreadsheet XML file Pilih Bagian yang

akan di download

~ Grade items to be include

[Deletion in progress] Kehadiran

KEHADIRAN KULIAH

[Deletion in progress] Teori Pengantar Ekonomi Baru
Pengantar Teori Ekonomi Baru

Penugasan Pertemuan 1

Course total

Select all/none

Download Hasil

- =

* Export format options

Gambar 111 Ekspor Nilai
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@ Savehs

4 = > ThisPC > DATA(D) > v
|
| Orgamize > New folder - @7
[0 This PC
¥ 3D Objects AKA
B Desktop DATA LAMA
|
IGN
Documents DESIG
DOSEN
& Downloads v AT
| MY DATA
D Music 0BS
&) Pictures @ Onedrive
B Videos UMUM

e Local Disk (C:)

= DATA (D) M -

File name: | ECINNEEEEE

Save astype: OpenDocument Spreadsheet

~ Hide Folders Cancel

Menyimpan Hasil
Nilai

Gambar 112 Menyimpan File Hasil Unduh

I. Troubleshooting
Setiap penerapan sistem pasti akan menemui kendala didalam prosesnya, baik pada mahasiswa
maupun dosen pengajar. Beberapa hal yang harus diperhatikan jika mengalami kendala didalam
penggunaan LMS, user dapat menghubungi operator program studi untuk menyelesaikan

permasalahan yang dihadapi. Kendala-kendala yang dapat diselesaikan diantaranya adalah:

Tidak/belum memiliki akun;
Tidak/belum terdaftar pada mata kuliah;
Belum/Terlewat waktu ceklist hadir;

Tidak terdapat materi perkuliahan;

A N

Salah kelas/Mata kuliah.

Sedangkan untuk kendala sistem ditangani langsung oleh pihak admin UIKA melalui Unit

Komputer dan Sistem Informasi (UKSI).
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LEARNING MANAGEMENT SYSTEM
Elearning atau pembelajaran online pada saat ini tidak dapat
dipisahkan dari pendidikan, keberadaannya kian jelas dibutuhkan
ditambah ketika Covid-19 melanda Indonesia diawal tahun 2020.

Dunia pendidikan “dipaksa” untuk mau menggunakan atau
bahkan beralih ke model pembelajaran secara daring (online).

Banyak aplikasi pendukung untuk media pembelajaran secara
daring, mulai WA, email, Youtube dan lainnya. Universitas Ibn
Khaldun Bogor Khususnya Fakultas Ekonomi dan Bisnis
menyediakan LMS (Learning Management System) yang berbasis
aplikasi MOODLE (Modular Object-Oriented Dynamic Learning
Environment) dimana melalui aplikasiini dosen dapat memberikan
materi berupa teks, web, animasi, ebook, presentasi, ujian dan
belajar secara daring.

Aplikasi LMS UIKA sudah terkoneksi dengan SPADA (Sistem
Pembelajaran Daring) Indonesia yang dikelola oleh Kementerian
Pendidikan dan Kebudayaan Republik Indonesia. Pada modul LMS
ini diuraikan penggunaan bagi admin, operator, dosen maupun
mahasiswa, dimana perbedaannya hanya pada hak akses LMS saja




